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Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.
Our mission is to:
1. Provide a Superior Customer Experience
« offer the best product quality and support
2. Make Cool Practical Technology
» develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and
empowers our employees. | hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to
us at solutions@rossvideo.com.

—D.‘Q 2\55

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a
special group. Our employees truly care about doing a great job and delivering a high quality customer
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our
behavior:

1. We will always act in our customers’ best interest.

We will do our best to understand our customers’ requirements.
We will not ship crap.

We will be great to work with.

o v bd

We will do something extra for our customers, as an apology, when something big goes wrong and
it's our fault.

We will keep our promises.
We will treat the competition with respect.

We will cooperate with and help other friendly companies.

© o N

We will go above and beyond in times of crisis. If there's no one to authorize the required action in
times of company or customer crisis - do what you know in your heart is right. (You may rent
helicopters if necessary.)
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Warranty and Repair Policy

Ross Video Limited (Ross) warrants its Streamline Play systems to be free from defects under normal use and
service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis,
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose,
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard
warranty period by one year increments. For more information about an extended warranty for your Streamline
Play system, contact your regional sales manager.



Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Company Address

Ross Video Limited

8 John Street
Iroquois, Ontario
Canada, KOE 1K0

General Business Office:

Fax:

Technical Support:

After Hours Emergency:

E-mail (Technical Support):
E-mail (General Information):

Website:

Ross Video Incorporated

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

(+1) 613 ® 652 © 4886
(+1) 613 ® 652 ® 4425

(+1) 613 @ 652 ® 4886
(+1) 613 @ 349 ® 0006

techsupport@rossvideo.com
solutions@rossvideo.com

http://www.rossvideo.com
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Introduction

A Word of Thanks

On behalf of our team here at Ross Video, I would like to thank you for choosing to buy a Streamline Play system.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life
of your investment. Our sales team are more than happy to provide further information on the plans available.
Members of our sales team promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Streamline Play system from Ross Video. We know that you will be very
pleased with your decision.

Yours Sincerely,

% S

Jenn Jarvis
Marketing Product Manager - Inception & Streamline
Jjjarvis@rossvideo.com

Streamline Play Configuration Guide (v1.0) Introduction ¢ 1-1
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About This Guide

This guide contains the following chapters that cover the configuration and use of Streamline Play software:
1. “Introduction” summarizes the guide and provides important terms, conventions and feature descriptions.

2. “Network Configuration” provides IP address configuration instructions for the Streamline, Streamline
Server, and Caprica components in your Streamline Play system.

3. “Streamline Configuration” provides configuration instructions for the Streamline media asset manager in
your Streamline Play system.

4. “Caprica Server Configuration” provides configuration instructions for the Caprica Server in your
Streamline Play system.

5. “Streamline Server Configuration” provides configuration instructions for the Streamline Server in your
Streamline Play system.

6. “Inception Configuration” provides configuration instructions for an Inception NRCS to work with your
Streamline Play system.

7. “Abekas Video Server Configuration” provides configuration instructions for the Abekas video server in
your Streamline Play system.

If you have questions pertaining to the operation of the Ross Video product, please contact us at the numbers listed
in the section “Contacting Technical Support” on page 1-3. Our technical staff is always available for
consultation, training, or service.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a
sequence of menus and sub-menus that must be followed to reach a particular command.
Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Work Order Manager panel, click Create New Work Order.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Creating a Work Order” in the Streamline Play User Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

* When Streamline Play cannot connect to the network, a Message dialog box opens to report the connection
problem.

1-2 ¢ Introduction Streamline Play Configuration Guide (v1.0)



Getting Help

The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the
product. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help
topics and User Guide:

¢ Contents — table of contents
* Index — keyword reference
¢ Search — full text search

» Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files on the Ross Video product Software
Installation DVD.

Contacting Technical Support

Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m.
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-652-4886
Toll free within North America: +1 844-652-0645

EMEA

Our EMEA center is located in Buckinghamshire, England, United Kingdom and is open Monday to Friday 8:30
a.m. to 5:00 p.m. GMT. After hours support is provided by our North America location.

Our telephone number is: +44 (0)1189502446
International toll free: +800 1005 0100

Emergency After-hours Support

Our telephone number is: +1-613-349-0006

Toll free within North America: +1 844-652-0645
International toll free: +800 1005 0100

Online

E-mail: techsupport@rossvideo.com

Website: use the link http://www.rossvideo.com/support/tech-support.html to open a support request.

Streamline Play Configuration Guide (v1.0) Introduction « 1-3
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Network Configuration

This chapter provides IP address configuration instructions for the Streamline, Streamline Server, and Caprica
components in your Streamline Play system. The following topics are discussed in this chapter:

¢ Set the Streamline IP Address
¢ Set the Streamline Server IP Address
+ Set the Caprica IP Address

Streamline Play Configuration Guide (v1.0) Network Configuration ¢ 2-1



Set the Streamline IP Address

Streamline runs on the host computer of the Streamline Play system.

* HOST (Streamline) IP address goes on the virtual switch.

Set the Streamline Server IP Address

The Streamline Server runs as a virtual machine on the host computer of the Streamline Play system.

» Use the Hyper-V Manager to access the Streamline Server virtual machine.

Set the Caprica IP Address

Caprica runs as a virtual machine on the host computer of the Streamline Play system.

» Use the Hyper-V Manager to access the Caprica virtual machine.
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Streamline Configuration

This chapter provides configuration instructions for the Streamline Server in your Streamline Play system. The
following topics are discussed in this chapter:

* Create a Streamline Server License

» Activate a Streamline Product Key

* Connect Streamline with the NCS

+ Create an Abekas Video Server Target

+ Set the Abekas Target as the Default Target

¢ Set the Streamline Service User

Streamline Play Configuration Guide (v1.0) Streamline Configuration ¢« 3—1



Create a Streamline Server License

Ross Video uses a product key and feature license keys to control user access to Streamline Server features. Before
you can license the Streamline Server in your Streamline Play system, you must create a license on the Ross Video
Activation Server for the Streamline Server. After you create a license, you must activate the license on the
Streamline Server.

To create a Streamline Server license
1. In a web browser, use the following URL to open the Ross Video Activation Server web page:
http://activation.rossvideo.com

The Ross Video Activation Server Login web page opens.

2. Use your Ross Video Activation Server credentials to log in to the web page.

3. Inthe License section of the main toolbar, click the Create License icon.

The New License dialog box opens.

©| New License. T

New License

Key E1YHX-BMEDN-58FD7

ot [Prease seea 7]

e [Gustomer <

Customerd [ ]

Porertumber | ]

Customertiame | ]

Description

Use the Product list to select Streamline.

Use the Edition list to select Standard Edition.

Use the Type list to select Customer.

In the Customer ID box, enter the identification number of the licensed customer.

In the PO/Order Number box, enter the purchase order number associated with the license.

x2S s

In the Customer Name box, enter the name of the licensed customer.

10. In the Description box, enter the a description of the license.
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11.

12.
13.

14.
15.

16.

17.

18.

Click OK.

The New License dialog box closes and a new license opens in the Licenses panel.

B streamiine Standard Edition - XBA TV [Licenses]

Feature ID Feature Name Description Humber Activation Limit | Current Activations Expiry Purchased | Created Modified
1 Helo 1 1 0 No Expry v |wezsisosis | 2017002816031
2 Waitenance Software maintenance subscripton for Streamine. Wie0z2s v miezsisoats | 2017002816031
s oS Upink Support for HOS upinking o Expiy v ezsisosis | 2017002816031
o Expiy 17.0028 140314 | 2017-0.28 140314
o Expiy 17.0028 140314 | 2017-0828 140314
o Expiy 17.0028 160314 | 2017-0.28 140314
o Expiy 17.0028 140314 | 2017-028 140314
10 No Expry v | mezsisosis | 20170028 14031
o Expiy 17.0028 140314 | 2017-0828 140314
o Expiy 17.0028 160314 | 2017-0.28 140314
o Expiy 17.0028 140314 | 2017-028 140314

2017-0326 140314 | 2017-03-28 140542

Click in the Purchased cell associated with the Feature ID 300.

Press the Space Bar.

The Ross Video Activation Server displays a check box in the selected Purchased cell.
Select the Purchased check box.

Click any other cell in the Licenses panel.

The Ross Video Activation Server displays a check mark in the selected Purchased cell and adds Feature ID
300 to the license.

Verify that the Purchased cell displays a check mark for the following Feature IDs:
L |

e 2

- 16

. 200

When a Purchased cell associated with a Feature ID does not contain a check mark, follow steps 12 to 15 to
add the feature to the license.

In the Licenses panel toolbar, click the [§ Copy icon.

The Ross Video Activation Server copies the product key for the new license to the clipboard. You can paste
the product key in a text file to hold the product key while you transfer it to the Streamline Server.

In the Logout section of the main toolbar, click the £ Logout icon.

Activate a Streamline Product Key

Ross Video uses product keys to manage user licenses for Streamline features.

* When you activate a Streamline product key, your Streamline Server computer must contact the Ross Video

Activation Server through the internet.

To activate a Streamline product key

1.
2.

Verify that the Streamline computer can connect to the Internet.
On the Desktop, double-click the Ross Streamline icon.

An Alert dialog box opens with the Ross Streamline web page.
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3. Inthe Alert dialog box, click OK.

The Alert dialog box closes and the Streamline Login dialog box opens.

streamline>

Usemame
Password

v Advanced

4. In the Streamline Login dialog box, enter the following user name and password in the provided boxes:

¢ Username — root

* Password — password

5. Click Login.

The Streamline Server logs you in as an Administrator.

6. In the Tools section of the main toolbar, click the [&] Configuration icon.

The Configuration panel opens.

7. Click the Licensing tab.

The Licensing Configuration tab opens.

) Configuration

Name.
Streamiine

1OS Uplink

Work Orders

Database | Licensin

Licensing Configuration
Please enter your product key as provided by Ross Video.

Status
Not Purchase
Not Purchase
Not Purchase
Not Purchase

a
a
a
a
Not Purchased
Not Purchased
Not Purchased
Not Purchased
Not Purchased

a

Not Purchasex

8. Copy the product key created in the procedure “To create a Streamline Server license” on page 3—2.

9. In the Product Key box, paste the product key created in the procedure “To create a Streamline Server

license” on page 3-2.

10. Click Activate.

After activating the entered product key, an Alert dialog box opens requesting a web browser window refresh.

11. Click OK

3—4 » Streamline Configuration
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The Alert dialog box closes and the Licensing Configuration tab updates to display the new feature licenses
associated with the activated product key. The Status column displays one of the following states:

Background Status Description

] Green Active The feature is active and available to Streamline users.

] Yellow Expires in # days  The feature availability for Streamline users expires in the displayed
number of days.

] Red Expired The feature has expired and is no longer available to Streamline
users.

] Red Invalid MAC The feature license key is invalid for the active network interface
card of the Streamline computer.

] White Not Purchased The feature is not accessible to Streamline users, but it is available
for purchase.

12. Click OK.

The Configuration dialog box closes.

Connect Streamline with the NCS

The Streamline Play system uses the MOS protocol to connect the Streamline Server with the system NCS.

To configure an uplink between a Streamline Server and an NCS

1. Log in to your Streamline Server as an administrator.

2. On the main toolbar, click the [z Configuration icon.

The Configuration window opens.

3. On the Configuration window toolbar, click the @ MOS icon. If the MOS icon is not visible, you are not an

administrator and cannot configure MOS connections.

The MOS panel opens.

) Configuration

MOS Configuration

identify this Streamine system as a MOS device

SBE@RE

Streamiine can be configured to communicate with Ross XPression and other systems using the MOS protocol. The MOS ID specified here is sed to uniquely

@uosio,  [STREANLIE

@enavencs 1
Uplnk

onso |

Oncswest |

4. Select the Enable NCS Uplink check box to establish a connection between the Streamline Server and the

NCS specified in the NCS ID and NCS Host boxes.
5. Inthe NCS ID box, enter the NCS ID of your NCS.

6. Inthe NCS Host box, enter the hostname or IP address of the NCS gateway.

7. Click OK.

Streamline Play Configuration Guide (v1.0)
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Create an Abekas Video Server Target

A target configured for an Abekas video server enables Streamline to push assets to the video server for playout
from the Streamline Play Playout Server.

To add an Abekas target

1. On the Configuration window toolbar, click the =% Asset icon.
The Configure Asset Storage panel opens.

2. Click the Targets tab.
The Targets tab opens.

) Configuration

H%E@E‘TAQAH‘

Asset Configuration | Targets | Transcoders | Watch Folders

Configured Targets

<
ASRNRN 4
PR+

3. Click Add.
The Attach Target page opens.
4. Use the Device list the select Uncertified Device.
5. Use the Target Type list to select File System.
6. Click Next.
The File System Target Configuration page opens.
7. Inthe Name box, enter Abekas as the name for the target.
8. Click in the Key Name box.
Streamline automatically enters an identifier name for the target. You can edit the entered name.

9. In the Path box, enter the full pathname on the Abekas video server of the shared folder in which to save assets
pushed from Streamline to the Abekas video server. This folder must be accessible to Streamline.

10. Click Next.

The Target Configuration page opens.
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11.

12.

13.

14.

15.

16.

17.

Use the Icon list to select an icon to identify the target.
If the icons in the list are not appropriate for your target, do the following:
a. Use the Icon list to select Upload an Icon.
Streamline displays a Browse button.
b. Click Browse.
The File Upload dialog box opens.
c. Use the File Upload dialog box to select the image file to use as the icon for your target.
d. Click Open.

Streamline adds the image contained in the selected image file to the Icon list as the Uploaded Icon option,
and automatically selects the uploaded image as the icon for your target. You can only upload one image to
the Icon list at a time. Uploading another image to the Icon list replaces the current uploaded image with
the new image.

Select the Require Approval check box to only allow users to send approved assets to the target. Clear this
check box to allow users to send unapproved or approved assets to the target.

In the Remove from Target After box, enter the amount of time after which to delete unused assets from the
target.

Use the Clip Name Case list to select the capitalization of clip names on the target. The available options are
as follows:

* Default — use the same capitalization as the asset filename (Sports Intro).
» All Uppercase — change all letters to uppercase (SPORTS INTRO).

* All Lowercase — change all letters to lowercase (sports intro).

Select the Replace Spaces With Underscores check box to replace all spaces in a clip name with underscore
(L) characters.

For example: the clip name Sports Intro would change to Sports_Intro.
In the Max Clip Name Length box, enter the maximum length in characters for clip names on the target.

The maximum clip length does not include the file extension. Clip names for assets with filenames longer than
the set maximum clip name length are truncated to the set length.

Click Edit Filter to open the Search Editor window to define a filter that controls the assets that users can
send to the target.

k Streamline only allows users to send assets to a target that match the filter defined for the target.

18.

Click Save.

Streamline adds the new target to the Configured Targets list.
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Set the Abekas Target as the Default Target

After you create the Abekas target, you must set the Abekas target as the default target that Streamline uses to push
assets to external devices.

This section outlines how to re-map the storage location for your assets to a folder on the Streamline Play Server.

To map the asset storage location to a folder

1. On the Configuration window toolbar, click the =% Asset icon.

The Configure Asset Storage panel opens.

) Configuration

Configure Asset Storage

@ Assetsorage patn” [Crteamine ]

@ Wite metadata to le on save o

2. Use the Default Target list to select the Abekas target that you created in the procedure “To add an Abekas
target” on page 3—6.

Streamline automatically sends uploaded asset files to the selected target.

3. Click OK to save settings and close the Configuration panel.

Set the Streamline Service User

You must also set the set the Streamline service to run as the Streamline user.
To set the user that runs the Streamline service
1. Log in to the Streamline Play computer using the following credentials:
User Name: streamline
Password: streamline
2. From the Windows Desktop, press Windows Key+R.
The Run dialog box opens.

= Run

— Typethe name of a program, folder, document, or Internet
=" resource, and Windows will spen it for you.

gpen [] 7]

3. Inthe Open box, type the following application name:

services.msc
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4.

Click OK.

The Services window opens.

T=m=|

> Services

File Action View Help

e EREEN E R

75 senices Loca| | [T Samices (Local)

Select an item to viewits description.  Neme - Description Status  StatupType  LogOnAs ~
5, ActiveX Installer (Ansts\) Provides User Account Control validation Manuzl Local Syste.
% dob ps your Adob... Running  Automatic  Local Syste =
5 App Readiness Gets apps ready for use the ist time a us. Manusl Local Syst.
 Application Experience Processes application compatibilty cache. Manusl (Trig... Local Syse.
 Application dentity Determines and verfes the identity of an Manual (Trig..~ Local Service
£ Application Information Facitatesthe running of nteractive appli. Running  Manual (Trg... Local Syste.
5 Application Layer Gateway Sevice Provides support for 3 party protocal pl. Manuzl Local Senvice:
* Application Management Processes nstalaton, removel, and enw..  Running  Manual Local Syst.
 AppX ) deploy. Manuzl Local Syst.
£ Background Inteligent Transters il usingidl.. Running  Manual Local Syste.
5 Background Task: " Running  Automatic  Local Syste
 Base Fiteing Engine The Base itering Engine (BFE)is 2 servic.. Running  Automatic  Local Service
5 Block Level Backup Engine Sevice The WEENGINE service i used by Windo. Manusl Local Syst.
£ Certficate Propagation Copies user certficates and root certficat... Running Manual Local Syst.
5 CNG Key solation The CNG key solation service is hosted n. Manusl (Trig... Local Syse.
5, COM» Event System Supports System Event Notfication Servic.. Running  Automatic  Local Service
5 COM+ System Application Manages the configuration and tracking Manual Local Syste.
% Computer Browser Maintains an updated lst of computers o Disabled Local Syst.
5 Credential Manager Provides secure storage and retreval of cr.. Running  Manual Local Syst.
% Cyptographic Services Provides three management services: Cat.. Runming  Automatic  NetworkS,
 DCOM Server Process Launcher The DCOMLAUNCH service launches CO... Running  Automatic  Local Syste
£ Dell KACE Agent Manages connections between agent and... Running Automatic Local Syste. v
Exended (Sandard

5. In the Services list, locate the Ross Streamline service.
6. Right-click the Ross Streamline service and select Properties from the shortcut menu.

The Ross Streamline Properties dialog box opens.

Ross Streamline Properties (Local Computer) 1|
General [ Log On | Recovery | Dependences
Service name: YRR

Displayriame:  Ross Streamine

Descrption: Sttt and stop the Ross Stearine appication. |~

Path to executable:
“C:\Program Fles\Ross Video\Streamine\Streamine.xe” 5 "C:\Program F

Servis status:  Runring

from here.

7. Click the Log On tab.
The Log On tab opens.

Ross Streamline Properties (Local Computer) ISl |
1a50n
Logons

Oir=frcr=—r
] Alow service to nteract with deskiop

O s account:

=3

8. Select the This account option.
9. In the This account box, enter streamline.
10. In the Password box, enter streamline.
11. In the Confirm Password box, enter streamline.
12. Click OK.
A Services alert dialog box opens.
13. Click OK.

A second Services alert dialog box opens.
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14. Click OK.
The Ross Streamline Properties dialog box closes.
15. In the Services window, use the File menu to select Exit.

The Services window closes.
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Caprica Server Configuration

This chapter provides configuration instructions for the Caprica Server in your Streamline Play system. The
following topics are discussed in this chapter:

* Create a Caprica Server License

» Activate a Caprica Server Product Key

* License Caprica Server Software

» Import Caprica Configuration

+ Set the Abekas Video Server Device IP Address
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Create a Caprica Server License

Ross Video uses a product key and feature license keys to control user access to Caprica Server features. Before
you can license the Caprica Server in your Streamline Play system, you must create a license on the Ross Video
Activation Server for the Caprica Server. After you create a license, you must activate the license on the Caprica
Server.

To create a Caprica Server license
1. In a web browser, use the following URL to open the Ross Video Activation Server web page:
http://activation.rossvideo.com

The Ross Video Activation Server Login web page opens.

2. Use your Ross Video Activation Server credentials to log in to the web page.

3. Inthe License section of the main toolbar, click the Create License icon.

The New License dialog box opens.

©| New License. T

New License

Key E1YHX-BMEDN-58FD7

ot [Prease seea 7]

e [Gustomer <

Customerd [ ]

Porertumber | ]

Customertiame | ]

Description

Use the Product list to select Caprica.

Use the Edition list to select Standard Edition.

Use the Type list to select Customer.

In the Customer ID box, enter the identification number of the licensed customer.

In the PO/Order Number box, enter the purchase order number associated with the license.

x2S ok

In the Customer Name box, enter the name of the licensed customer.

10. In the Description box, enter the a description of the license.
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11.

12.
13.

14.
15.

16.

17.

18.

Click OK.

The New License dialog box closes and a new license opens in the Licenses panel.

IR Caprica Standard Edition - XBA TV [Licenses]

Feature ID Feature Name Description umber Activation Limit | Current Activations Expiry. Purchased  Created Modified

1 Caprica Caprica Unimited 0 No Expiry v |2o7e3s0103720 | 20170330 103720
10 Roboics Control Support for Robotics Control No Expiry 20170330 10:37:20 | 2017-03:30 10:37.20

" Kayak Switchers Support or Kayak Swichers No Expiry 20170330 10:37:20 | 2017-03:30 10:37:20

No Expiry 20170330 10:37:20 | 2017-03:30 10:3720

No Expiry 20170330 10:37:20 | 2017-03:30 10:37.20

No Expiry 20170330 10:37:20 | 2017-03:30 10:37:20

No Expiry 20170330 10:37:20 | 2017-03:30 10:3720

[
1
1
1
1
1 No Expiry 20170330 10:37:20 | 2017-03:30 10:37.20
1
1
1
Uniimted No Expiry 20170330 10:37:20 | 2017-03:30 10:37.20
1

No Expiry 20170330 10:37:20 | 2017-03:30 10:37.20

Click in the Purchased cell associated with the Feature ID 18.

Press the Space Bar.

The Ross Video Activation Server displays a check box in the selected Purchased cell.
Select the Purchased check box.

Click any other cell in the Licenses panel.

The Ross Video Activation Server displays a check mark in the selected Purchased cell and adds Feature ID
18 to the license.

Verify that the Purchased cell displays a check mark for Feature ID 1.

When a Purchased cell associated with a Feature ID does not contain a check mark, follow steps 12 to 15 to
add the feature to the license.

In the Licenses panel toolbar, click the [§ Copy icon.

The Ross Video Activation Server copies the product key for the new license to the clipboard. You can paste
the product key in a text file to hold the product key while you transfer it to the Caprica Server.

In the Logout section of the main toolbar, click the ] Logout icon.

Activate a Caprica Server Product Key

Ross Video uses product keys to manage user licenses for Caprica Server features.

* When you activate a Caprica Server product key, your Ross Licensing Service computer must contact the Ross

Video Activation Server through the internet.

Internet Accessible

When your Streamline Play system has access to the internet, the Ross Licensing Service can directly communicate
with the Ross Video Activation Server to active your Caprica Server product key and license Caprica Server
software.
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To activate a Caprica Server product key for a Streamline Play system connected to the internet
1. Verify that the Ross Licensing Service computer can connect to the Internet.
2. In a web browser, use the following URL to open the Ross Licensing Service web page:
http://<Streamline Server IP>:3030
Replace <Streamline Server IP> with the IP address of the Streamline Server.

The Ross Licensing Service Login web page opens.

Usemame
Password

v Advanced

3. Inthe Ross Licensing Service Login dialog box, enter the following user name and password in the provided
boxes:

¢ Username — root

¢ Password — password
4. Click Login.
The Ross Licensing Service web page opens.
5. In the Licensing section of the main toolbar, click the [£§ Activate License icon.

The Licensing Configuration dialog box opens.

6. Inthe Product Key box, paste the product key created in the procedure “To create a Caprica Server license”
on page 4-2.

7. In the Product Version box, enter 3. 2.
8. Click Activate.

After activating the entered Caprica Server product key, an Alert dialog box opens requesting a web browser
window refresh.

9. Click OK.

10. Use the activated Caprica Server product key in the procedure “To install OverDrive feature licenses on the
OverDrive Server:” on page 4—13 to license Caprica Server features on your Caprica Server.

Private Network
When your Streamline Play system cannot access the internet, you must use the Ross Offline Licensing Tool to

communicate over the internet with the Ross Video Activation Server.

Install Ross Offline Licensing Tool Software

Before you can license a Streamline Play system that cannot access the internet, you must install the Ross Offline
Licensing Tool on a computer that can communicate over the internet with the Ross Video Activation Server.
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To install the Ross Offline Licensing Tool

1. Connect a USB Flash Drive to the Ross Licensing Service computer.

2. In a web browser, use the following URL to open the Ross Licensing Service web page:
http://<Streamline Server IP>:3030
Replace <Streamline Server IP> with the IP address of the Caprica Server.

The Ross Licensing Service Login web page opens.

Usemame
Password

v Advanced

3. At the Ross Licensing Service Login screen, enter the following user name and password in the provided
boxes to log in as an Administrator:

¢ Username — root

¢ Password — password
4. Click Login.

The Ross Licensing Service web page opens.

5. In the Tools section of the main toolbar, click the [[J Download Ross Offline Licensing Tool icon.
6. Save the offline-licensing-tool.msi installer file to a USB Flash Drive.

7. Connect the USB Flash Drive to a computer that can communicate over the internet with the Ross Video
Activation Server.

8. On the USB Flash Drive, double-click the offline-licensing-tool.msi installer file.

The Ross Offline Licensing Tool Setup wizard opens

) ROSS Offin Licensing Too!Setup x

Welcome to the ROSS Offline
Licensing Tool Setup Wizard

erd wil nstal ROSS Offine Licensing Tool on
ick Next” to contnue or “Cancel” o exit

9. Click Next.

The Select Installation Folder screen opens.

8 ROSS Offin Licensing ToolSetup - x

Select Installation Folder
This s the foder where ROSS Offine Licensing Tool wil be instalid,

Toinstal i this folder, cick Next”. To nstal to  different folder, enter it below or clck.
“Bronse”.

e
[G2Pregrm FiesRoss VdeotoFine Lizrang Toall Bonse,

‘Advanced Installer
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10. Click Next.

The Ready to Install screen opens.

8 ROSS Offin Licensing ToolSetup

Ready to Install
The Setup Wizard i ready to begin the ROSS Offine Licensing Toolnstalation

X

Clck Tnstal” to begin the instalaion. IF you want to review or change any of your
cick B

. Click “Cancel”

‘Advanced Installer

11. Click Install.

Cancel

After installation of the Ross Licensing Service is complete, the Installation Complete screen opens.

8 ROSS Offine Licensing ToolSetup

X

Completing the ROSS Offline
Licensing Tool Setup Wizard

Clck the Firish” button to exit the Setup Wizard,

12. Click Finish.

The Ross Licensing Service Setup wizard closes.

License a Caprica Server on a Private Network

After you install the Ross Offline Licensing Tool on a computer that can communicate with the Ross Activation
Server, your are ready to activate a Caprica Server product key for your Streamline Play system.

* You must generate an activation file from each Ross Licensing Service computer in your Streamline Play system
and active the matching license file for each Ross Licensing Service.

To activate a Caprica Server product key for a Streamline Play system on a private network

1. Connect a USB Flash Drive to the Ross Licensing Service computer.

2. On the Desktop of a Ross Licensing Service computer, double-click the Ross Licensing Service icon.

The Ross Licensing Service Login screen opens.

Usemame
Password

v Advanced

3. Atthe Ross Licensing Service Login screen, enter the following user name and password in the provided

boxes to log in as an Administrator:

¢ Username — root

¢ Password — password
4. Click Login.

The Ross Licensing Service web page opens.
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10.
11.
12.

13.

14.
15.

16.

17.

In the Licensing section of the main toolbar, click the [Z] Activate License icon.

The Licensing Configuration dialog box opens.

@ Licensing Configuration

Licensing Configuration
Please enter product key and the software version,

Product Key

Product

Note: Activation fle il be saved to your

In the Product Key box, paste the product key created in the procedure “To create a Caprica Server license”
on page 4-2.

In the Product Version box, enter 1. 0.
Click Save Activation Information.

The Licensing Configuration dialog box closes and the Ross Licensing Service saves a license.activation file
to your Downloads folder.

Copy the license.activation file from your Downloads folder to the USB Flash Drive connected to the Ross
Licensing Service computer.

Disconnect the USB Flash Drive from the Ross Licensing Service computer.
Connect the USB Flash Drive to the computer that you installed the Ross Offline Licensing Tool.

On the Desktop of the Ross Offline Licensing Tool computer, double-click the Ross Offline Licensing Tool
icon.

The Ross Offline Activation Tool opens.

] Ross Offline Activation Tool o x

wepﬁon streamline> ovardrive

In the Ross Offline Activation Tool, click Upload Activation info.

The Open dialog box opens.

Use the Open dialog box to select the Locate and open the license.activation file to the USB Flash Drive.
Click Open.

The Ross Offline Activation Tool displays the Product Key, Hardware Unique ID, and Software Version
contained in the selected license.activation file.

Click Activate.
The Specity a file to save license file dialog box opens.

Select the USB Flash Drive as the location to save the license file.
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18.
19.

20.
21.

22.

23.

24.
25.

26.

27.

28.

In the File Name box, enter a file name for the license file.

Click Save.

The Ross Offline Activation Tool saves a license file for the Ross Licensing Service to the USB Flash Drive.
Disconnect the USB Flash Drive from the Ross Offline Licensing Tool computer.

Connect the USB Flash Drive to the Ross Licensing Service computer.

In the Ross Licensing Service, click the . Browse for License File icon in the Licensing section of the main
toolbar.

The Upload Licensing File dialog box opens.

3 Upload Licensing File

Please select a licence file to upload :
Browse.

Upload Cancel

Click Browse.

The File Upload dialog box opens.

Use the File Upload dialog box to select your license file from the connected USB Flash Drive.
Click Open.

The File Upload dialog box closes and the Upload Licensing File dialog box displays the name of the selected
license file.

Click Upload.

After uploading the selected license file, an Alert dialog box opens reporting a successful upload.
Click OK.

The Alert and Upload Licensing File dialog boxes close.

Use the activated Caprica Server product key in the procedure “To install OverDrive feature licenses on the
OverDrive Server:” on page 4—13 to license Caprica Server features on your Caprica Server.

License Caprica Server Software

Ross Video uses a product key and feature license keys to control user access to Caprica Server features. The Ross
Licensing Service verifies the your Caprica Server product key and enables access to the Caprica Server features
you purchased from Ross Video.

* Before you can license Caprica Server features, your must activate your Caprica Server product key on the Ross

Licensing Service in your Streamline Play system. Refer to the section “Activate a Caprica Server Product
Key” on page 4-3 for information on activating Caprica Server product keys.

To license a Caprica Server

1.

Use a web browser to open the Caprica web page URL. The format of the URL is as follows, where
<Caprica Server> is the hostname or IP address of your Caprica Server computer:

https://<Caprica Server>:9090

If the web browser identifies your connection with the Caprica web page as not secure, add an exception for the
Caprica web page.

* If the Caprica web page does not open, your Caprica Server computer is not running the CentOS 7 operating

system. Contact Ross Video Technical Support to upgrade the operating system of your Caprica Server
computer.
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The Caprica Login web page opens.

Laponrica

User name server: caprica

Loginwithyo
password

2. Use the following credentials to log in to the Caprica web page:
e User: caprica

¢ Password: password
3. Click Log In.

The Caprica web page opens.
4. In the tree view, click License.

The License web page opens.

License - localhost - Mozilla Firefox

4® License -localhost x| 4
€ localhost wBe 9 3 A4 =
[ Most Visitedv &% Centos @Wiki @ Documentation @ Forums

CAPRICA

[E tocathost

Resource

Upgrade License
Diskset

Cluster License Server Address
License B

License Server Port
> System Tools

License Key

5. In the License section, enter the IP address or hostname of your Ross Licensing Service computer in the
License Server Address box.

6. Inthe License Server Port box, enter the network port number of Ross Licensing Service.
Port 3030 is the default network port for the Ross Licensing Service.

7. Inthe License Key box, paste the product key created in the procedure “To create a Caprica Server license”
on page 4-2.

8. Click Apply.
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9. In the tree view, click Resource.

The Resource web page opens.

Resource - localhost - Mozilla Firefox

4 Upgrade - localhost % | 4

€ localhost c ] w e + A =

10. In the Caprica Service section, use the list to the right of the Active Caprica Service to select Restart.

Import Caprica Configuration

Streamline Play uses Caprica to communicate with the video server in your Streamline Play system. The Streamline
Play software DVD contains diskset files to configure Caprica to communicate with an Abekas 2, 4, 6, or 8 channel
video server. After you load the appropriate diskset for your Abekas video server, you must use Dashboard to set
the IP address of the video server to enable Caprica to connect with the video server.

Load Configurations from a Diskset File

You can load the configurations contained any diskset file listed in the Diskset section of the Diskset web page into
the Caprica Server.

* Loading a configuration from a diskset file replaces the current configuration of the Caprica Server with the
configuration contained in the selected diskset file.

To load the configurations from a diskset file on to the Caprica Server
1. Insert the Streamline Play software DVD into the DVD-ROM drive of the local computer.

2. Use a web browser to open the Caprica web page URL. The format of the URL is as follows, where
<Caprica Server> is the hostname or IP address of your Caprica Server computer:

https://<Caprica Server>:9090
The Caprica Login web page opens.
3. Use the following credentials to log in to the Caprica web page:

e User: caprica

¢ Password: password
4. Click Log In.

The Caprica web page opens.
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5. In the tree view, click Diskset.

The Diskset web page opens.

& Diskset - 10.0.20030 x G

€ ) ® @ | https://10.0.200.30:9090/caprica/diskset e Search © B U ¥ A d

save configuration || Default configuration

> System Tools Diskset Upload diskset

6. In the Diskset section, click the Upload diskset.
The Upload Diskset dialog box opens.

Upload Diskset

Select a diskset to upload

Browse... | No file selected.

7. Click Browse.
The File Upload dialog box opens.
8. Open the Caprica Device Interface folder in the Streamline Play software DVD.

9. Select the diskset file that matches the number of channels on your Abekas video server. The available diskset
files are as follows:

* Caprica-2Channel.tgz — 2 channel Abekas video server
* Caprica-4Channel.tgz — 4 channel Abekas video server
* Caprica-6Channel.tgz — 6 channel Abekas video server

* Caprica-8Channel.tgz — 8 channel Abekas video server
10. Click Open.

The File Upload dialog box closes and the Upload Diskset dialog box displays the name of the selected
diskset file.

11. In the Upload Diskset dialog box, click Upload.

The Upload Diskset dialog box closes and Caprica adds the selected diskset file to the Diskset section of the
Diskset web page.

12. In the Diskset section, click the diskset file to load on to the Caprica Server.

A section opens for the selected configuration file.

Caprica-2Channel Recall || Download || Delete

e Caprica-2Channel
e 03/30/2017 022235

 17.99K8

13. Click Recall.
An Alert opens.
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14. Click Recall.

Caprica loads the configuration contained the selected diskset file and automatically restarts to start using the
new configuration. Click Cancel to cancel loading configurations from the selected configuration file into the
Caprica Server.

15. To return to the Diskset panel, click Diskset in the breadcrumb menu above the configuration file section.

Set the Abekas Video Server Device IP Address

After you load the appropriate diskset for your Abekas video server, you must use Dashboard to set the IP address
of the video server to enable Caprica to connect with the video server.

To set the Abekas Video Server Device IP Address
1. Use one of the following methods to launch DashBoard:
* Double-click the DashBoard icon on the desktop.

» Use the Start menu to select All Programs > DashBoard > DashBoard.
2. In the DashBoard Tree View, expand the Caprica Server node.
3. Inthe Caprica Server node, expand the Slot 0: Caprica node.
4. Double-click the Port Configuration node.
The Port Configuration client opens in the Device View.
5. Use the Window menu to select Full Screen.

The Port Configuration client expands to full screen view.

Port Configuration Summary Port Details: SWITCHER 1

Port

™ SWITCHER 1 cher: Caprica  TCH ener - IP.0.0.0.0 Port 9999
I RevoTE 1
[ RevoTE

REMOTE 3
REMOTE 4
REMOTE 5
REMOTE 6
REMOTE 7
REMOTE 8
REMOTE 9
REMOTE 10
REMOTE 11
REMOTE 12
REMOTE 13
REMOTE 14
REMOTE 15

REMOTE 16

caprica
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6. In the Port column of the Port Configuration Summary table, double-click REMOTE 1.
The Configure REMOTE 1 panel opens.

Port Configuration Summary Configure REMOTE 1

CHER 1
M REMOTE 1 nerVIR VOCP  TCP Client - IP:127.0.0.1 Port 8000

L] P ToP 001

127.0.01

8000 <

0.0.0.0

REMOTE 16

caporica

7. Click Network Settings.

8. In the Remote IP Address box, enter the IP address of the Abekas video server in your Streamline Play
system.

9. Inthe Remote Port box, enter the port number that the Abekas video server uses to communicate with external
applications or devices.

10. Click Apply Changes.
11. Repeat steps 6 to 10 for each device you want to connect to your OverDrive Server.

12. Click Done to close the Configure REMOTE # panel.
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Streamline Server Configuration

This chapter provides configuration instructions for the Streamline Server in your Streamline Play system. The
following topics are discussed in this chapter:

* Load Templates

* Create a Streamline Server License

+ Activate a Streamline Server Product Key

» License Streamline Server Software

* Configure Caprica Communication Settings
* Configure a MOS Gateway for the NRCS

* Configure Templates
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Load Templates

The Sequencer uses Master and Device templates to playout assets from the Abekas video server in the Streamline
Play system. The Streamline Play software DVD contains backup files (.odv5) to load Master and Device templates
for an Abekas video server with 2, 4, 6, or 8 channels.

* You must load templates before you license the Streamline Server.

To load templates for the Abekas video server in your Streamline Play system
1. Close the Streamline Server, Streamline MOS Gateway, and Sequencer.

2. Use one of the following methods to start RapidRestore:

* On the desktop, double-click the RapidRestore icon.
* Use the Start menu to select All Programs > OverDrive > RapidRestore.

The OverDrive RapidRestore window opens.

 OverDrive RapicRestore - x
Fie el

overdrive

-
.. ‘; . rapid restore

h

e

3. Click Restore From Backup.
The Select File screen opens.

4. Click Browse to select the backup file from which to restore OverDrive settings and rundowns.

The Open dialog box opens.

5. Open the Playout Server folder in the Streamline Play DVD.

6. Select the backup file that matches the number of channels on your Abekas video server. The available backup
files are as follows:

* Streamline-2Channel.ovd5 — 2 channel Abekas video server
* Streamline-4Channel.ovd5 — 4 channel Abekas video server
* Streamline-6Channel.ovd5 — 6 channel Abekas video server
* Streamline-8Channel.ovd5 — 8 channel Abekas video server

RapidRestore enters the name of the selected file in the File Name box.

7. Click Open.

The Open dialog box closes and RapidRestore enters the full path to the selected backup file in the File Name
box on the Select File screen.
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8.

10.

11.
12.

13.

14.

15.

16.

In the Select File screen, click Next.

The Select Packages screen opens, listing the OverDrive clients that have packages that can be restored from
the selected backup file.

7 OverDrive Restore Wizard X

Select Packages overdrive

Use the Package list on the left to select the RundownControl package.

Click Add Package.

RapidRestore adds the RundownControl package to the Restore list on the right.
Add the Server and Template Editor packages to the Restore list.

Click Finish.

The Checking Prerequisites screen opens.

7 OverDrive Restore Wizard X

Checking Prerequisites overdrive

Click Next.

The Restoring Backup screen displays the restore progress. When the restore completes, the Restore
Complete alert opens.

Click OK.

The alert closes, and the Restoring Backup screen displays the results of the restore.
Click Close.

The OverDrive Restore Wizard closes.

In OverDrive RapidRestore window, click Close to exit RapidRestore.
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Create a Streamline Server License

Ross Video uses a product key and feature license keys to control user access to Streamline Server features. Before
you can license the Streamline Server in your Streamline Play system, you must create a license on the Ross Video
Activation Server for the Streamline Server. After you create a license, you must activate the license on the
Streamline Server.

To create a Streamline Server license
1. In a web browser, use the following URL to open the Ross Video Activation Server web page:
http://activation.rossvideo.com

The Ross Video Activation Server Login web page opens.

2. Use your Ross Video Activation Server credentials to log in to the web page.

3. Inthe License section of the main toolbar, click the Create License icon.

The New License dialog box opens.

©| New License. T

New License

Key E1YHX-BMEDN-58FD7

ot [Prease seea 7]

e [Gustomer <

Customerd [ ]

Porertumber | ]

Customertiame | ]

Description

Use the Product list to select OverDrive.

Use the Edition list to select Express Edition.

Use the Type list to select Customer.

In the Customer ID box, enter the identification number of the licensed customer.

In the PO/Order Number box, enter the purchase order number associated with the license.

x2S s

In the Customer Name box, enter the name of the licensed customer.

10. In the Description box, enter the a description of the license.
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11. Click OK.

The New License dialog box closes and a new license opens in the Licenses panel.

Expiry. Purchased  Created Modified
1 Unimted 0 No Expiry v |o7eazstestos 20170320 14510 4
2013-0329 v |vrosastesios | 20170320 14510

1 No Expiry 20170329 1451:03 | 2017-03:29 14510

1 No Expiry v |70a2testos 20170329 14510
@ Coding Only Clent 1 No Expiry 20170329 1451:03 | 2017-03:29 14510

1 Template Edtor Unimted No Expiry v |2o70329testos | 20170329 14510

Unimted No Expiry 20170329 1451:03 | 2017-03:29 14510

Unimited No Expiry 20170329 1451:03 | 2017-03:29 14510
Uniimted No Expiry 20170329 1451:03 | 2017-03:29 14510

Unimted No Expiry 20170329 1451:03 | 2017-03:29 14510

Unimted No Expiry 20170329 1451:03 | 2017-03:29 14510

w2 P Unimited No Expiry 20170329 1451:03 | 2017-03:29 14510

12. Click in the Purchased cell associated with the Feature ID 52.
13. Press the Space Bar.
The Ross Video Activation Server displays a check box in the selected Purchased cell.
14. Select the Purchased check box.
15. Click any other cell in the Licenses panel.

The Ross Video Activation Server displays a check mark in the selected Purchased cell and adds Feature ID
52 to the license.

16. Repeat steps 12 to 15 to add the following Feature IDs to the license:
* 56
. 57
17. Click in the Purchased cell associated with the Feature ID 404.
18. Press the Space Bar.
The Ross Video Activation Server displays a selected check box in the Purchased cell.
19. Clear the Purchased check box.
The Ross Video Activation Server removes Feature ID 404 from the license.
20. Repeat steps 17 to 19 to add the following Feature IDs to the license:
+ 407
+ 408
* 409
* 410
21. Verify that the Purchased cell displays a check mark for the following Feature IDs:
1
e 2
e 12
14
+ 304
* 405
* 406

When a Purchased cell associated with a Feature ID does not contain a check mark, follow steps 12 to 15 to
add the feature to the license.
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22. In the Licenses panel toolbar, click the [ Copy icon.

The Ross Video Activation Server copies the product key for the new license to the clipboard. You can paste
the product key in a text file to hold the product key while you transfer it to the Streamline Server.

23. In the Logout section of the main toolbar, click the [ Logout icon.

Activate a Streamline Server Product Key

Ross Video uses product keys to manage user licenses for Streamline Server features.

* When you activate a Streamline Server product key, your Ross Licensing Service computer must contact the
Ross Video Activation Server through the internet.

Internet Accessible

When your Streamline Play system has access to the internet, the Ross Licensing Service can directly communicate
with the Ross Video Activation Server to active your Streamline Server product key and license Streamline Server
software.

To activate a Streamline Server product key for a Streamline Play system connected to the internet
1. Verify that the Ross Licensing Service computer can connect to the Internet.

2. Use a web browser to open the Ross Licensing Service web page URL. The format of the URL is as follows,
where <Streamline Server> is the hostname or IP address of your Streamline Server computer:

http://<Streamline Server>:3030

The Ross Licensing Service Login web page opens.

Usemame
Password

v Advanced

3. Inthe Ross Licensing Service Login dialog box, enter the following user name and password in the provided
boxes:

¢ Username — root

¢ Password — password
4. Click Login.
The Ross Licensing Service web page opens.
5. Inthe Licensing section of the main toolbar, click the [£§ Activate License icon.

The Licensing Configuration dialog box opens.

@ Licensing Configuration 2 x

Licensing Configuration
Please enter product key and the software version,

Actvate Cancel

6. Inthe Product Key box, paste the product key created in the procedure “To create a Streamline Server
license” on page 5-4.

7. In the Product Version box, enter 16. 3.
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8. Click Activate.

After activating the entered Streamline Server product key, an Alert dialog box opens requesting a web
browser window refresh.

9. Click OK.

10. Use the activated Streamline Server product key in the procedure “To install OverDrive feature licenses on
the OverDrive Server:” on page 4-13 to license Streamline Server features on your Streamline Server.

Private Network

When your Streamline Play system cannot access the internet, you must use the Ross Offline Licensing Tool to
communicate over the internet with the Ross Video Activation Server.

Install Ross Offline Licensing Tool Software

Before you can license a Streamline Play system that cannot access the internet, you must install the Ross Offline
Licensing Tool on a computer that can communicate over the internet with the Ross Video Activation Server.

To install the Ross Offline Licensing Tool
1. Connect a USB Flash Drive to the Ross Licensing Service computer.

2. Use a web browser to open the Ross Licensing Service web page URL. The format of the URL is as follows,
where <Streamline Server> is the hostname or IP address of your Streamline Server computer:

http://<Streamline Server>:3030

The Ross Licensing Service Login web page opens.

Usemame
Password

v Advanced

3. Atthe Ross Licensing Service Login screen, enter the following user name and password in the provided
boxes to log in as an Administrator:

¢ Username — root

¢ Password — password
4. Click Login.

The Ross Licensing Service web page opens.

5. In the Tools section of the main toolbar, click the [ Download Ross Offline Licensing Tool icon.
6. Save the offline-licensing-tool.msi installer file to a USB Flash Drive.

7. Connect the USB Flash Drive to a computer that can communicate over the internet with the Ross Video
Activation Server.
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8. On the USB Flash Drive, double-click the offline-licensing-tool.msi installer file.
The Ross Offline Licensing Tool Setup wizard opens

8 ROSS Offine Licensing ToolSetup x

Welcome to the ROSS Offline
Licensing Tool Setup Wizard

9. Click Next.

The Select Installation Folder screen opens.

ing Tool il be nstalled E

Toinstal i this folder, cick Next”. To nstal to  different folder, enter it below or clck.
okt

e
[G2Pregrm FiesRoss VdeotoFine Lizrang Toall Bonse,

‘Advanced Installer

10. Click Next.

The Ready to Install screen opens.

8 ROSS Offin Licensing ToolSetup x

Ready to Install
The Setup Wizard i ready to begin the ROSS Offine Licensing Toolnstalation

Clck Tnstal” to begin the instalaion. IF you want to review or change any of your
cick Back". Clck Cancel

‘Advanced Installer

<ok B [ conce

11. Click Install.

After installation of the Ross Licensing Service is complete, the Installation Complete screen opens.
18) ROSS Offine Licensing Tool Setup x

Completing the ROSS Offline
Licensing Tool Setup Wizard

Clck the Firish” button to exit the Setup Wizard,

12. Click Finish.

The Ross Licensing Service Setup wizard closes.
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License a Streamline Server on a Private Network

After you install the Ross Offline Licensing Tool on a computer that can communicate with the Ross Activation
Server, your are ready to activate a Streamline Server product key for your Streamline Play system.

* You must generate an activation file from each Ross Licensing Service computer in your Streamline Play system
and active the matching license file for each Ross Licensing Service.

To activate a Streamline Server product key for a Streamline Play system on a private network
1. Connect a USB Flash Drive to the Ross Licensing Service computer.
2. On the Desktop of a Ross Licensing Service computer, double-click the Ross Licensing Service icon.

The Ross Licensing Service Login screen opens.

Usemame
Password

v Advanced

3. Atthe Ross Licensing Service Login screen, enter the following user name and password in the provided
boxes to log in as an Administrator:

¢ Username — root

¢ Password — password
4. Click Login.
The Ross Licensing Service web page opens.
5. In the Licensing section of the main toolbar, click the Activate License icon.

The Licensing Configuration dialog box opens.

@ Licensing Configuration 2 x

Licensing Configuration
Please enter product key and the software version,

Note: Activation fle ill be saved to your "Downloads” folder

Save Actvation Information Cancel

6. Inthe Product Key box, paste the product key created in the procedure “To create a Streamline Server
license” on page 5—4.

7. In the Product Version box, enter 1.0.
8. Click Save Activation Information.

The Licensing Configuration dialog box closes and the Ross Licensing Service saves a license.activation file
to your Downloads folder.

9. Copy the license.activation file from your Downloads folder to the USB Flash Drive connected to the Ross
Licensing Service computer.

10. Disconnect the USB Flash Drive from the Ross Licensing Service computer.

11. Connect the USB Flash Drive to the computer that you installed the Ross Offline Licensing Tool.
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12. On the Desktop of the Ross Offline Licensing Tool computer, double-click the Ross Offline Licensing Tool
icon.

The Ross Offline Activation Tool opens.

(2] Ross off

%cepﬁon streamline> ovardrive

Activation Information:

13. In the Ross Offline Activation Tool, click Upload Activation info.

The Open dialog box opens.
14. Use the Open dialog box to select the Locate and open the license.activation file to the USB Flash Drive.
15. Click Open.

The Ross Offline Activation Tool displays the Product Key, Hardware Unique ID, and Software Version
contained in the selected license.activation file.

16. Click Activate.
The Specity a file to save license file dialog box opens.
17. Select the USB Flash Drive as the location to save the license file.
18. In the File Name box, enter a file name for the license file.
19. Click Save.
The Ross Offline Activation Tool saves a license file for the Ross Licensing Service to the USB Flash Drive.
20. Disconnect the USB Flash Drive from the Ross Offline Licensing Tool computer.

21. Connect the USB Flash Drive to the Ross Licensing Service computer.

22. Inthe Ross Licensing Service, click the g Browse for License File icon in the Licensing section of the main
toolbar.

The Upload Licensing File dialog box opens.

3 Upload Licensing File

Please select a licence file to upload :
Browse.

Upload Cancel

23. Click Browse.

The File Upload dialog box opens.
24. Use the File Upload dialog box to select your license file from the connected USB Flash Drive.
25. Click Open.

The File Upload dialog box closes and the Upload Licensing File dialog box displays the name of the selected
license file.
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26. Click Upload.

After uploading the selected license file, an Alert dialog box opens reporting a successful upload.
27. Click OK.

The Alert and Upload Licensing File dialog boxes close.

28. Use the activated Streamline Server product key in the procedure “To install OverDrive feature licenses on
the OverDrive Server:” on page 4-13 to license Streamline Server features on your Streamline Server.

Ross Video uses a product key and feature license keys to control user access to Streamline Server features. The
Ross Licensing Service verifies the your Streamline Server product key and enables access to the Streamline Server
features you purchased from Ross Video.

Before you can license Streamline Server features, your must activate your Streamline Server product key on the
Ross Licensing Service in your Streamline Play system. Refer to the section “Activate a Streamline Server
Product Key” on page 5—6 for information on activating Streamline Server product keys.

To install Streamline Server feature licenses on the Streamline Server

1. Use a web browser to open the Streamline Server Web Administration web page URL. The format of the
URL is as follows, where <Streamline Server> isthe hostname or IP address of your Streamline Server
computer:

http://<Streamline Server>

The Streamline Server web page opens.

B overdrive X+

<« O | 10ee16070 ¥

M
N I
O a

streamline>

manage install

server clients
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2.

Click Manage Server.

The Streamline Server - Login web page opens in a web browser window.

1 OverDrive Server - Logit X + -

a
< ® | mmmo %l =% o -

streamline>

streamline>

StreamLine Server Web
Ad tration

User login s required to access this page.

Enter the following user name and password in the provided boxes:

¢ Username — streamline

¢ Password — password

Click Login.

The Streamline Server - Main web page opens.
Use the Configuration menu to select License.

The License Configuration web page opens.

3 Overrive Server - Licen X+ - o x

< ® | mmmo %l =% o -

streamline> o B B

N DEVICE TooLS MONITOR

10.0.0.144
3030
CNXM3-62RC6-1525D

Apply Configuration

In the License Settings section, enter the IP address or hostname of your Ross Licensing Service computer in
the License Server Address box.

In the License Server Port box, enter the network port number of Ross Licensing Service.

Port 3030 is the default network port for the Ross Licensing Service.
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8. In the Product Key box, paste the product key created in the procedure “To create a Streamline Server
license” on page 5—4.

9. Click Apply Configuration.

10. Restart your Streamline Play system.

Configure Caprica Communication Settings

The Server Configuration web page enables you to configure the Streamline Server to communicate with the
Caprica Server in your Streamline Play system.

To configure your Streamline Server to communicate with the Caprica Server
1. In the OverDrive Server web page, use the CONFIGURATION menu to select Server.

The Server Configuration web page opens.

B Overbrive Server - Conf X 4

< ® | mmmo %l =% o -

streamline>

CONFIGURATION DEVICE TooLS MONITOR

| Primary/Redundant Server Configuration

Primary Server Host I

| switcher Protocol Configuration

Use Caprica Interface [

| Dual Switcher Mode Configuration

Enable Dual Switcher Mode u

| Frame Configuration

Host 127.001
Apply Configuration

2. In the Switcher Protocol Configuration section, select the Use Caprica Interface check box.

The Caprica Interface Connection section opens.

3. Inthe Caprica Interface Connection section, enter the IP address of the Caprica Server or Caprica Server
Cluster in the Host box.

To view the IP address of the Caprica Server, hover your mouse over the Caprica Server node in the
DashBoard Tree View.

* The default port number 12345 in the Network Port box should not be changed. If you need to change the

network port number, please contact Ross Video Technical Support. Refer to the section “Contacting Technical
Support” on page 1-3 for contact details.

4. Click Apply Configuration to save and apply the frame and panel port settings.
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5. Use the TOOLS menu to select System Services.
The System Tools web page opens.

1 OverDrive Server - Syste X+

< O | 10sate070

streamline> e 1

(O MLES)

TION DEVICE To0LS MONITOR ABOUT

S System Tools

<& OverDrive Services Management

Host Service

\\SRVOTTOVDLIVE e

MOS Gateway Host NRCS

\\10.64.160.70 Start Mos G: Stop Mos Gateway Restart Mos Gateway|

6. Inthe OverDrive Services Management section, click Restart.

Caprica is connected to your Streamline Server when the Switcher LED icon at the top of the OverDrive
Server Web Administration web page turns green.

Configure a MOS Gateway for the NRCS

To enable Streamline Server to connect with the NRCS in your Streamline Play system, you need to configure a
MOS Gateway for the NRCS.

To configure MOS Gateway settings for an NRCS:

1. Use the Configuration menu to select Gateway.

The MOS Gateway Configurations page opens, listing the MOS Gateways on an OverDrive system.

3 OverDrive Server - MOS X+

< O | 10sate070

streamline> et 1

@® paubase @ server (@) Backup Mode er (4 MLES)
»
Tion DEVICE To0Ls MONITOR BAC ABOUT

@- MOS Gateway Configuration

Contigure yourhOS =
| NRCS Configuration

Name Type NRCSID  NRCSMOS Server Primary Gateway Redundant Gateway

Default NONE  ROSS w Wocalhost [id: OverDrive]

Note: The Gateway services need to be re-started following changes to the configuration settings.
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2. Inthe NRCS Configuration section of the MOS Gateway Configurations page, click Edit to the right of the
Default MOS Gateway.

The Edit NRCS section opens.

Primary Redundant

NRCS ID
OD GW Host Address. OD GW Host Address.
0D MOS Low Port

0D MOS Low Port

0D MOS High Port

oD mos D ‘on Mos D

0D MOS High Port

3. Use the Newsroom System list to select the NRCS to use in the your production environment.

4. Select the Enable MOS command control in gateway check box to add the Command section to the
Rundown Info tab. Clear this check box to hide the Command section in the Rundown Info tab. This check
box is cleared by default.

You can use the Command section to monitor MOS Messages and troubleshoot communications between the
NRCS and OverDrive.

5. Verify that the Send MOS Heartbeats to NCS check box is selected to send heartbeat data to the NRCS
selected from the Newsroom System list. The NRCS uses heartbeat information to verify network and
gateway continuity.

* You should only clear the Send MOS Heartbeats to NCS check box under the direction of Ross Video
Technical Support when troubleshooting connectivity issues between your NRCS and OverDrive.

6. Configure QNews v1.5 or QNews specific settings. The following setting is only available when you select
QNews v1.5 or QNews from the Newsroom System list:

* Remove Rundown when MOS server stops exporting — select this check box to make the MOS Gateway
remove the NRCS rundown when it receives a remove message from the MOS Server. This option is
selected by default.

7. Inthe Primary section, enter the ID that OverDrive uses to access the NRCS n the NRCS ID box. Refer to the
NRCS client for the correct NRCS ID.

8. Inthe NRCS MOS Server Host Address box, enter the hostname or IP address of the NRCS server computer.
The NewStar NRCS does not require this setting.

9. Inthe OD GW Host Address box, enter the host name or IP address of the computer running the primary
MOS Gateway.

10. In the OD MOS ID box, enter the MOS ID assigned to the OverDrive Primary system by the NRCS.
11. In the MOS Low Port box, confirm the default value of 10540.

Changing the port number of the MOS Low Port setting stops all running services and disconnects all clients
from the MOS Gateway. Ross Video recommends using the default port number unless otherwise specified.
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12. In the MOS High Port box, confirm the default value of 10541.

Changing the port number of the MOS High Port setting stops all running services and disconnects all clients
from the MOS Gateway. Ross Video recommends using the default port number unless otherwise specified.

13. When your OverDrive system contains a Redundant MOS Gateway, use the Redundant section,
Redundant/Buddy for ENPS, to configure the following settings for the Redundant MOS Gateway:

a.

b.

For the ENPS NRCS, enter the NRCS ID for the ENPS Buddy MOS Server in the NRCS ID box.

In the NRCS MOS Server Host Address box, enter the hostname or IP address of the Redundant NRCS
server computer. For the ENPS NRCS, enter in this box the hostname or IP address of the ENPS Buddy
Server.

The NewStar NRCS does not require this setting.

In the OD GW Host Address box, enter the host name or IP address of the computer running the
Redundant MOS Gateway.

In the OD MOS ID box, enter the MOS ID assigned to the OverDrive Redundant system by the NRCS.
In the MOS Low Port box, confirm the default value of 10540.

Changing the port number of the MOS Low Port setting stops all running services and disconnects all
clients from the Redundant MOS Gateway. Ross Video recommends using the default port number unless
otherwise specified.

In the MOS High Port box, confirm the default value of 10541.

Changing the port number of the MOS High Port setting stops all running services and disconnects all
clients from the Redundant MOS Gateway. Ross Video recommends using the default port number unless
otherwise specified.

14. Click Save.

OverDrive saves the MOS Gateway settings and the Edit NRCS section closes.

15. Use the TOOLS menu to select System Services.

The System Tools web page opens.

16. In the OverDrive Services Management section, click Restart Mos Gateway.

Configure Templates

Each Device template requires a MOS ID and each MOS ID requires an association with a default template. The
Template Editor enable you to edit the MOS ID settings for Device templates.
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Set the Template Editor Network Connection

Before you can use the Template Editor to edit templates, you must configure the Template Editor to connect to the
Streamline Server in your Streamline Play system.

To configure network connection properties for TemplateEditor:
1. Use one of the following methods to start TemplateEditor:
* On the desktop, double-click the TemplateEditor icon.

» Use the Start menu to select All Programs > OverDrive > TemplateEditor.

TemplateEditor opens.

StreamLinePlay TemplateEditor

cut
cut
cut
cut
cut
cut
cut
cut
cut
cut
cut
cut

streamline>

2. Use the Tools menu to select Network Setup.

The Network Setup dialog box opens.

B Network Setup -

Network Setup

3. Inthe Networks Settings section, enter the IP address or hostname of the Streamline Server in the Primary
Server box.

4. Click Test Host Connection.
The Template Editor tests the connection to the set Primary Server, and reports one of the following results:

* Succeeded — TemplateEditor is connected to the set Primary Server.

* Failed — TemplateEditor could not connect to the set Primary Server.
5. Click OK to save connection properties and close the Network Setup dialog box.

The Server status LED icon in TemplateEditor dialog box turns green when TemplateEditor connects to the
selected OverDrive Server.
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Set Device Template MOS ID

For each video server Device template defined for your Streamline Play system you have to set the MOS ID for the
video server.

To set the MOS ID for a video server Device template
1. In the TemplateEditor, click the Devices tab.

The Devices tab opens.

[} StreamLinePlay TemplateEditor [= =)

Devices

Devices

Type

Vitlen Sarver Chan12
Vitdeo Server Chan 12
Viddeo Server Chan 12
Viddeo Server Chan34
Viddeo Server Chan34
Viddeo Server Chan34
Viddeo Server Chans 6
Viddeo Server Chans 6
Video Server Chan 5 &

Devices CrosspointPort
Chan 1, Chan 12, Chan 2 7. Swarc 1
Chan 3, Chan 3 4, Chan 4 4.9ware 3
Chan 5, Chan &, Chan § & 6 9ware 5
Chan 7, Chan 8, Chan 7 8 8 gwarc 7

streamline>

2. Use the Devices list to select a video server Device template to edit.
3. Click Edit.

The Editing Device dialog box opens.

a Chan 1 (Video Server) [E3]
Editing Device : Chan 1

Back To Back

P G int R
Crosspoint 2

4. Inthe Video Server Properties section, enter the MOS ID of your Abekas video server in the MOS ID box.
5. Click Save to save the MOS ID set for the video server.

The Editing Device dialog box closes.

For each video server Device template in the Devices tab Devices list, repeat steps 2 to 5 to set the MOS ID.
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Select the Default MOS Template of a Device

The TemplateEditor does not automatically create a Master Template for MOS Video Server devices. For each
video server Device template defined for your Streamline Play system you have to select a Master Template for the
video server.

To select a Master Template for a MOS video server Device template
1. In the TemplateEditor, use the Tools menu to select Configure MOS Video Server Templates.

The Configure MOS Video Server Templates dialog box opens.

a Configure Default MOS Video Server Templates -

—

MOS Video Server Type L Description L Master Template
STREAMLINE MOS ID: Undefined
STREAMLINE MOS ID:, D:5 104- Chan
STREAMLINE MOS ID:, [ 105- Chan
STREAMLINE MOS ID:, Channel ID: 7 106- Chan
STREAMLINE MOS ID:, Channel ID: 8 107 - Chan
STREAMLINE MOS ID: STRMLNED MOS 108- Chan

STREAMLINE MOS ID: STRMLNED MOS, Channel ID: 1 108~ Chan
STREAMLINE MOS ID: STRMLNED.MOS, Channel ID: 2 101 - Chan
STREAMLINE MOS ID: STRMLNED.MOS, Channel ID: 3 102-Chan
STREAMLINE MOS ID: STRMLNED.MOS, Channel ID: 4 103- Chan

2. Inthe MOS Video Server Type column, select the type of MOS Video Server device for which you want to
select a default Master Template.

3. Click Browse.

The Template Selection dialog box opens displaying the Master Templates that use the selected type of MOS
Video Server device in at least one ME.

a Template Selection -

Template Selection

J Master Templates.
L Termplates

NoTnamonan 104 Chans 0 Floating  Enabled 1

NoTnumonan 105 Chané 0 Floating  Enabled 1

NoTnumonan 108 Chan7 0 Floating  Enabled 1

NoTnamonan 107 Chang 0 Floating  Enabled 1

NoTnamonan 119 Chans 6 0 Floating  Enabled 1

NoTamonat 111 Chan7g 0 Floating  Enabled 1

4. Select the Master Template to use as the default Master Template for the selected type of MOS Video Server
device.

You can only select one Master Template as the default Master Template for a type of MOS Video Server
device.

5. Click the OK.

The Template Selection dialog box closes. The Master Template column in the Configure MOS Video
Server Templates dialog box displays the name of the Master Template selected for a MOS Video Server

type.

6. For each video server Device template listed in the Configure MOS Video Server Templates dialog box,
repeat steps 2 to 5 to set the MOS ID.
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7. To change the default Master Template used by a selected MOS Video Server type, click Browse.
8. To remove the default Master Template used by a selected MOS Video Server type, click Clear.

9. Click OK to save the your MOS Video Server type default Master Template settings and close the Configure
MOS Video Server Templates dialog box.

10. In the TemplateEditor, use the File menu to select Exit.
The TemplateEditor closes.

11. Restart the Streamline Play system computer.

Connect RundownControl with the Streamline Server

Before you can use an instance of RundownControl to open and work with NRCS rundowns, you must set the IP
address of the Streamline Server for the instance.

To connect RundownControl with the Streamline Server
1. On the desktop, double-click the Rundown Control icon.

When RundownControl contains user profiles in addition to the overdrive (Default User) user profile, the
Select User dialog box opens. For RundownControl systems that only contain the overdrive (Default User)
user profile, skip to the results of step 3.

ar Select User And Operation Mode [E3]]

Coding Client

Plea:

Overdrive (Default User)
streamline (streamline playout server)

To work without a user profile during a RundownControl session, do the following:
a. Click the Select User dialog box Windows Close button.
b. Skip to the results of step 3.
2. From the User list, select the user profile to work with for the RundownControl session.
The selected user profile defines the following preferences for the RundownControl session:

» Custom perspective layout

* Hot key assignments

* Timer settings

* Custom Control button assignments

* Rundown table column layout

* Setting on the Rundown Settings, GPI, and NRCS Settings tabs in RundownControl Options dialog box.

Any preference changes made during an RundownControl session are saved with the selected user profile.
3. Click Select User.

For users that have a password, the Enter Password dialog box opens.
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To enter a user password, follow these additional steps:
a. In the Enter Password box, enter the password for the selected user profile.
b. Click OK.

RundownControl opens using the user preferences from the selected user profile, displayed in the
RundownControl title bar.

4. Use the Tools menu to select Options.
The Options dialog box opens.

5. Click the Network Settings tab.
The Network Settings tab opens.

B Options =1

Network Settings

rPlayout Status

6. In the Networks Settings section, enter the IP address or hostname of the Streamline Server in the Primary
Server box.

7. Click Test Host Connection.

OverDrive tests the connection between RundownControl and the set Primary Server, and reports one of the
following results:

* Succeeded — RundownControl is connected to the set Primary Server.

+ Failed — RundownControl could not connect to the set Primary Server.
8. Click OK to save changes and close the Options dialog box.

The Server status LED icon turns green when RundownControl connects to the selected Streamline Server.
9. In Rundown Control, use the File menu to select Exit.

The Exit dialog box opens.
10. Click Yes to exit RundownControl.

RundownControl closes.
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Inception Configuration

When you use Inception as the NRCS in your Streamline Play system, you must configure Inception MOS devices
for the Streamline Play. This chapter provides instructions on how to create MOS devices in Inception. The
following topics are discussed in this chapter:

* Create the Streamline Play Edition MOS Device
* Create the Streamline Play MOS Device
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Create the Streamline Play Edition MOS Device

The Streamline Play Edition MOS device enables Inception to communicate with the Streamline component in your
Streamline Play system.

To add a the Streamline Play Edition MOS device to Inception
1. In aone of the following supported web browsers, navigate to the Inception web page.

* Microsoft Internet Explorer® version 9 or greater
* Mozilla Firefox® version 3.6 or greater
* Google Chrome™ browser version 17.x or higher

* Apple Safari® version 5.1.x or greater

The Login panel opens.

%cepﬁon

Username

2. In the Login panel, enter your system administrator login credentials in the Username and Password boxes.
The default system administrator login credentials are as follows:

¢ Username — root

¢ Password — password
3. Click Login.

Inception opens.

* When Inception displays a message indicating that the system is in maintenance mode, a system administrator
must establish a database connection before you can log in to your Inception Server.

4.  On the main toolbar, click the [E] Configuration icon. If the Configuration icon is not visible, you are not an
administrator and cannot configure the server.

The Configuration window opens.

5. On the Configuration window toolbar, click the @ MOS icon.
The MOS panel opens.

6. Click the Devices tab. If the Devices tab is not visible, you do not have an NCS license for your Inception
Server and you cannot add MOS devices to your the server.

The Devices tab opens.

& Contiguratio
T . =TT >
o = 73 4 ABC, %9
2 ] & e <%
Usink | Devices nos
MOS Devi
= o vescrpon | ugin bled  Story Send  Formatted Text
= v [ overore v v v v
¥ [ soression v v v v
Ena haa Eat | [ peete
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10.
11.
12.

13.

14.
15.

Click Add.

The Create MOS Device page opens and displays the Device Settings section for the new MOS device.
Use the Device list to select Ross Streamline.

In the MOS ID box, enter the MOS ID of the Streamline component in your Streamline Play system.

In the Host box, enter the hostname or IP address of the Streamline component in your Streamline Play system.
In the Name box, enter Streamline Play Edition.

Click Next.

The next page opens and displays the MOS Plugin section for the new MOS device.

Click Next.

The next page opens and displays the Appearance and the MOS Settings sections for the new MOS device.
Use the Icon list to select an icon for the Streamline Play Edition MOS device.

Click Save.

Inception adds the Streamline Play Edition MOS device to the MOS Devices list.

Create the Streamline Play MOS Device

The Streamline Play Edition MOS device enables Inception to communicate with the Streamline Server component
in your Streamline Play system.

To add a the Streamline Play Edition MOS device to Inception

1.

e A

10.

11.
12.
13.
14.
15.

In the Devices tab of the Configuration window, click Add.

The Create MOS Device page opens and displays the Device Settings section for the new MOS device.
Use the Device list to select Uncertified Device.

In the MOS ID box, enter the MOS ID of the Streamline Server component in your Streamline Play system.

In the Host box, enter the hostname or IP address of the Streamline Server component in your Streamline Play
system.

Use the MOS Version list to select 2.8.4.

In the Name box, enter Streamline Play.

Select the Enabled check box.

Click Next.

The next page opens and displays the MOS Plugin section for the new MOS device.
Use the Plugin list to select None.

Click Next.

The next page opens and displays the Appearance and the MOS Settings sections for the new MOS device.
Use the Icon list to select an icon for the Streamline Play MOS device.

Select the Enable Story Send check box.

Clear the Enable Placeholders check box.

Clear the Enable Timing Control check box.

Click Save.

Inception adds the Streamline Play MOS device to the MOS Devices list.
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Abekas Video Server
Configuration

This chapter provides configuration instructions for the Abekas video server in your Streamline Play system. The
following topics are discussed in this chapter:

» Set Up a Watch Folder on the Abekas Video Server
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Set Up a Watch Folder on the Abekas Video Server

A watch folder on the Abekas video server stores the media items that Streamline pushes to the video server. The
Abekas video server can ingest media items from the watch folder for playout. Settings for the watch folder on the
Abekas video server are as follows:

¢ Name — H:\watch

* Share with User — streamline. The streamline users must be a local user with the same password as per the
host Streamline user account.
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